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IMPORTANT NOTICES
• Before nstallng and usng the devce, please read ths manual carefully 
and keep t for further use. 
• Ths manual s an ntegral part of the product. It should be gven to the new 
owner n order for them to know the nstallaton, operaton and safety 
nstructons. 
• Improper nstallaton of the devce removes the responsblty of the 
manufacturer. 

WARNING
• To avod the rsk of fre and electrc shock, never expose ths equpment to 
ran or mosture!

SAFETY PRECAUTIONS
1. Please read the nstructons carefully, as they contan mportant nformat-
on.

2. The voltage of the power supply of ths devce has hgh values, whch 
creates a rsk of electrc shock. For ths reason, never nstall, connect or 
dsconnect ths product whle the power supply s connected.

3. The metal parts of the product are grounded wth an electrc cable. If the 
electrcal outlet that supples electrcty s not grounded, call a qualfed 
electrcan who wll ground the product through the termnal.

4. To prevent damage to the cable, make sure the power supply cable s not 
crushed or broken.

5. To avod the rsk of electrc shock, never open the product: there are no 
user fxable parts nsde.

6. Make sure that foregn bodes or lquds do not come n contact wth 
speakers, as ths may cause short crcut.

7. Never try to perform repars whch are not mentoned n ths manual. 
Contact the authorzed servce center or hghly qualfed personnel f;
 a. The product s not operatng (or abnormally operatng),
 b. Serous damage s done to the power supply cord,
 c. Foregn bodes or lquds get nto the product,
 d. The product s exposed to heavy mpact.

8. Turn off the product, f not used for a long tme and dsconnect the power 
supply cord.

9. If the product emts a strange odor or smoke, turn off mmedately and 
dsconnect the power supply cord.

PRECAUTIONS
• Do not cover ventlaton of the product.
• Do not allow amplfer to operate wth an excessve load for a long tme. 
• Tghten the screws on the speakers frmly to guarantee safe contact. 
• Do not use thnner, alcohol or other volatle substances when cleanng 
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CAUTIONS RELATED TO THE USE OF ELECTRICAL LINE

• When pluggng and unpluggng the power cord, t should be held frmly to 
avod rsk.
• In case t won’t be used for a long tme, the plug of the unt should be 
unplugged to cut off the electrcty.
• To avod damagng the power cord, do not break, pull or harm the cord 
wth sharp and ponty materals. Use a grounded socket.

POSITIONING 

• It should be placed wth t’s sdes and back 1 meter away from the wall and 
should not be placed n the followng envronments;
• Humd envronment
• Under drect sunlght and other strong heat emtters
• Envronments wthout ventlaton
              

CONTROL OF THE UNIT

• Make sure that the power supply s turned off, that the power supply and 
the other devces and lnes connected wth ths unt are dsconnected from 
the power supply. 
• Do not remove ths unt. Do not attempt to dsassemble and fx ths devce 
yourself. Otherwse there may be a rsk of electrc shock or fre. If you can’t 
solve the problems wth the methods outlned later n ths manual, you 
should call a qualfed techncan or consult our company. Enforcng the 
system could may electrcal shock or fre. 

CLEANING

• When ths unt needs to be cleaned, use a clean damp cloth etc. to dust. Do 
not use solvents such as benzene, thnner alcohol, strong volatle substan-
ces, bleach or other flammable lquds for cleanng the body of the unt. 
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2. DEVICE OVERVIEW

This user manual has been written for the users to understand the system 
architecture effectively and to use all the components of the system effectively.

ESCO/RP10 is a TCP/IP based audio decoder and has many hardware features. Since 
its main function is audio, there are two balanced audio outputs on its rear panel. 
With it’s digital and analog inputs, many features are programmable.

The RP10 is part of an announcement system and can work as a system component 
on its own or in conjunction with other RP10 components. When it is used in the 
announcement system, it can give the announcements made over the ESCO/MA7 
device from its output. More than one RP10 can be used in a system. 

The system works over the network. Stand-alone use is also possible depending on 
configurations. Any input from a music source can be routed to output. The RP10 is 
designed completely in a modular structure. The user can configure according to 
her wishes and use it by transforming it into different structures.

The system architecture has been developed to be used as TCP/IP-based over 
Ethernet. System configurations are made with the desktop interface. All settings 
related to the system can be made easily. There is a web server on each device. 
Interfaces can be configured independently of each other.

RP10 is very easy to set up as a system. Once included, it continuously works as a 
part of the system. Due to the widespread use of the IP network structure, no 
external audio cabling is necessary and the system becomes more traceable with 
extra features such as keeping track of the operations.

ESCO/RP10 can decode G.711/G.722/WAV/MP3. It can play stream data from network 
(other ESCO/RP10 devices or ESCO/MA7 device) by decoding them according to 
their data type. Stream from the network should be 48000Hz for inputs such as 
microphone input and line input.

On RP10, all sources in the system have priority options. Playback stops are 
performed according to the priority structure that you have created while installing 
the system.

One of the most important features of the ESCO/RP10 is that it evaluates every 
incoming data and plays the data from the highest priority source, while recording 
lower priority data from other sources. It plays the recorded audios as soon as the 
system is available. In case of accumulation of more than one record, the operation 
will be: fist come first served. The memory stores up to 8 recordings, above that will 
not be recorded. This way, when the announcement is over, it continues to 
broadcast music in sync with other RP10s.

Please find detailed functions and specifications below.
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2.a. Characteristics

 • Built-in 2x50W amplifier when supplied with 30VDC

 • 10/100 MB Ethernet over RJ45/ CAT6 connection

 • Supports TCP, UDP, RTP, IGMP, HTTP, FTP, DHCP and NTP protocols

 • Accepts 44100 Hz MP3 and 48000 Hz analog audio

 • 4 digital input and 1 analog output

 • Access control relay

 • Configuration over desktop interface

 • System log recording

2.b Functions
Front;
 • 1 mini jack headphone output

 • 1 Ethernet interface

 • 1 RS485 input  

 • Power LED

 • Status LED

 • Reset button

Rear;
 • 1 balanced line output

 • 4 digital input

 • 1 balanced line input

 • 2 speaker output

 • 1 contact (relay) output

 • 20-30VDC power supply input
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Figure 1 RP10 Front Panel

3. CONTROLS, CONNECTORS & INDICATORS
3.a. Front Panel

1. RS485: 4 pin connector for communication with SV8 volume and

channel controller. Please see Block Diagram 2.

2. ETHERNET: 10/100MB RJ45 socket used for audio data transfer, device 

configurations. It is recommended to use with CAT6 cable.

3. HEADPHONE: 3.5mm mini-jack used as headphone input. 

4. RESET: Button used for returning device to factory settings. To return to factory 

settings press the button for 5 seconds. 

5. STATUS: LED for monitoring device status. Flashing LED means RP10 is working 

properly.

6. POWER: LED for monitoring power supply. Constantly lighting LED means RP10 is 

supplied with power and working.  

RP-10
ETHERNETGND A B 5V

RS485

HEADPHONE

RESET
made n

21 3 4 5 6



3.b. Rear Panel

1. POWER: 20-30VDC power supply socket.

2. CONTACT OUTPUT: Programmable contact relay outputs. Configuration generally 
done via ESCO/MA7. For markings please see Table 1.

3. CONTACT INPUTS: Digital inputs operating by logic 1 and 0. IN1 and IN2 contacts 
perform the programmed tasks, IN3 and IN4 contacts activate the “Line Input” part. 
Digital inputs are isolated. Please see Block Digram 2.

4. SPEAKER OUTPUTS: 2 speaker output lines.
  
5. LINE OUTPUTS: Balanced audio line outputs. It is recommended to use shielded 
cable. For markings please see Table 2.

6. LINE INPUTS: Balanced audio line input. It is recommended to use shielded cable. 
For markings please see Table 2.

NOT: Depending on the configuration, one of the Line Inputs can also be used as a 

microphone input. This requires a hardware change. For more information, you 

can contact our company via:  info@mikafon.com.tr

8
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Figure 2 RP10 Rear Panel

Table 1 Analog Contact Markings

Table 2 Line Input/Output Markings
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4. SYSTEM FUNCTIONS

4.1. Interface Installation Procedure

To download the interface to your computer, go to: www.mikafon.com.tr >> 
Products >> EVAC Control Systems >> Controllers, click on RP10 and download RP10's 
interface, "MAS Setup", from the "Downloads" page. Then the “.exe” file in the 
downloadeds is clicked and the installation is completed.

Before using the interface, the computer must be in 192.168.1 IP block, which the 
device statically receives. When the device is turned on, it will enter any IP in the 1st 
block. In order to ensure that the IPs of the device and the computer are not the 
same, the IP address of the device is checked. To get the IP block of the computer to 
the 192.168.1 block, following operations are required for Microsoft operating 
systems: "Network Connections > Ethernet > Properties > Internet Protocol Version 4 
(TCP/IPv4) > Use the following IP address". The Default Gateway should also be 
192.168.1.1. Firewall of the computer should be deactivated in order to find the IP of 
devices.

4.2. Interface Guide

RP10s in the LAN are found and managed via the interface. In addition, it allows 
various professional audio settings to be adjusted. In order to find the device, the 
Ethernet input on the front panel must be connected directly to the computer to 
which the interface will be installed or to the switch to which the computer is 
connected to. Before starting to use the interface, the following table should be 
examined

Table 3 Interface Tree of Contents



1. Main Menu

After the interface is downloaded from www.mikafon.com.tr and installed on the 
computer, double click on the application icon is and open the program in Figure 3.

1.1. Project

Project tab allows creating a new project (New) or opening an existing one (Open).

10

Figure 3 Interface Main Menu

Figure 4 Project Menu



1.1.a. New

Click on Project → New tab to create a new project. In that window (see Figure 5), 
the file path and file name are entered and the Save button is clicked.

1.1.b Open

Click the Project → Open tab to open an existing project. In that window (see Figure 
6), the desired file is selected and the “Open” button is clicked.
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Figure 5 New Project Menu

Figure 6 Open an Existing Project



1.2. Tools

Devices are managed, found and updated from here. This section is available for 
use only if a new project is opened or an existing project is opened. After opening 
a new project, the following steps are applied from the Tools menu in order to 
start adjusting device settings. 

Device Finder         Device Finder             Device Manager

   

Tools menu is explained in detailed in the following chapters.

1.2.a. Device Manager

Devices added to the interface are listed here. See Figure 8. For example, when a 
new project is created, the amplifiers that appear in the left column can be deleted 
by clicking the "►" sign from the "Device Manager" section and clicking the "Delete" 
button.

After the registration of RP10 is done from “Device Finder” section, it can be viewed  
here. For the registration process, see 1.2.b. By double-clicking on the device which 
is listed in the "Device Manager" section, type and name of the device can be 
entered and changed. See Figure 9.
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Figure 7 Tools Menu

/  Find the devices /  Enter the Gateway

    IP to found device

/  Enter device

    information 

/  List all devices



i. List (Add) Device

The device configuration menu is opened by double-clicking the “►” sign in the left 
column of the device list. The features listed below can be changed from here. The 
MAC address should not be changed.

 • Type: Device type (RP10, DP500 etc.)

 • Name: Device name

 • IP: IP address of the device

 • Gateway: Gateway address of the device

 • Netmask: Netmask address of the device

 • DNS1/DNS2: DNS settings of the device

 • MAC: The Mac address information of the device is *Automatically given.
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Figure 8 Device Manager Menu

Figure 9 Add Device Menu



ii. Delete Device

Used for removing device(s) added to the interface. Click on the desired line to be 
removed from the list, and then click on the “Delete” button. The deletion process is 
completed by clicking the "Yes" button in the window that pops-up. See Figure 10.

1.2.b. Device Finder

Used for adding devices to the interface. In the “Enter IP Blog:” section, enter the IP 
block of the device/devices and click on the “Find Devices” tab. Gateway IP section 
is filled in the menu entered by double-clicking the “►” sign at the beginning of the 
line of the listed device/devices and the “Save” button is clicked. See Figure 11. If 
desired, the device type and name can also be entered. After this process, the 
device is listed in the "Device Manager" section where a name is given to the device. 

After the above processes, Device Finder Menu, device name on the left coulumn is 
double clicked to access professional sound settings. Please see following sections 
(i - vi) for details.  
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Figure 10 Delete Device Menu

Figure 11 Device Finder Menu



i. Volume Control Menu

1. Network Audio Devices: The section where the model/device whose settings are to 
be changed is selected. There is no need to make this selection again in other 
menus.

2. Channel Control: There is a control bar for each output. To increase the volume of 
the output, the blue marker is moved up, and to decrease the volume, scrolled 
down. It is recommended not to do this move too fast to avoid damaging the 
speakers connected to the system. This should be done by moving the bar slowly 
while listening to the sound. 

3. Channel Sound Level Indicator: Numeric display of sound level.

4. Mute / Unmute: Icon for muting the relevant output without changing the volume.

ii. Low Pass & High Pass Menu

Please see Figure 13.

1. LP & HP Filter Settings: LP is frequency band settings between 2000 Hz and 22 kHz, HP 
is between 20 Hz and 1000 Hz. The output frequency can be adjusted by sliding the 
blue marker up or down.

2. Channel Frequency Indicator: Display of the set frequency band below the 
corresponding channel.

15

Figure 12 Volume Control Menu
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Figure 13 Low Pass & High Pass Menu

Figure 14 Equalizer Menu



1. Gain Setting: The output frequency can be adjusted by sliding the blue marker.
2. dB Indicator: Tuned frequency of the corresponding channel in dB . The desired 
value can also be written manually into this box.
3. Hz Indicator: Frequency display of the adjustment made above. 
4. Set: The center and bandwidth frequencies can be changed from the screen that 
pops up when the box is clicked. Thus, 5 different bands can be changed as desired 
and customized. See Figure 15. 
5. Active: This button can control each output separately. Passive channel will work 
as flat. See Figure 16

iv. Settings Menu

1. Gain Setting: Music is streamed to 8 channels over MS40. 1 of 8 channel is selected to 
broadcast from RP10. Music can be muted automatically when an announcement is 
made via the emergency microphone or when there’s a fire contact

17

Figure 15 Frequency Set Menu

Figure 16 Passive Condition

Figure 17 Settings Menu
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5. INSTALLATION INSTRUCTIONS

The Audio Decoder RP10 is suitable for desktop or 19-inch rack installation. The 

device is designed so that 4 units fit side by side in a 19” rack cabinet. When placing 

the device in the rack cabinet, the ventilation gaps should not be blocked and it 

should be fixed to the rack cabinet in order for it to work smoothly. For mounting

holes, see Figure 18. Make sure that there is enough space around the side walls of 

the device when placing it on the tabletop or in the rack cabinet

Figure 18 RP10 Rack Shelf Mounting Holes

 If the devices are to be placed in a rack cabinet, it is necessary to use the  

                  tray specially produced in our company for RP36s.

To initialize the system, connections are made in accordance with the 

above-mentioned explanations. After the IP settings and necessary configurations 

are made through the interface, the device is powered from the rear panel via the 

20-30VDC input. If the Power LED on the front panel of the device is on continuously 

and the Status LED is flashing, the RP10 is ready to use. 

To fix the RP10s to the rack,

fix them with a phillips

screwdriver through the holes

using M3x6mm pan head screws.



19



20

RP
10

 B
LO

C
K 

DI
AG

RA
M

 1

Dy
na

m
ic

M
ic

ro
ph

on
e

LA
N/

WA
N 

M
A7

M
S4

0

RS
48

5

SV
8

20
-3

0V
DC Fi
re

 P
an

el

x4
C

on
ta

ct
 In

pu
t

C
on

ta
ct

 O
ut

pu
t

DP
50

0

DO
C

-8
/1

6

C
M

10
0

or

4

x1
x2

RP
-1

0
ET

H
ER

N
ET

G
N

D
A

B
5V

RS
4

85

H
EA

D
PH

O
N

E

RE
SE

T
m

ad
e 

n

RP
10



21

RP10 BLOCK DIAGRAM 2
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AUDIO DECODER

GARANTİ BELGESİ
Bu belgenn kullanılmasına; 4077 sayılı Tüketcnn Korunması Hakkında 
Kanun ve bu Kanun'a dayanılarak yürürlüğe konulan Garant Belges 
Uygulama Esaslarına Dar Yönetmelk uyarınca, T.C. Sanay ve Tcaret 
Bakanlığı İl Müdürlüğü tarafından zn verlmştr.

 
 

 
 

İMALATÇI FİRMANIN
ÜNVANI:
MERKEZ ADRESİ:
TELEFON:
FAKS: 

MİKAFON ELEKTRONİK İNŞ.SAN.LTD.ŞTİ.
Şar Zya Paşa Cad. No: 8/A 34420 Karaköy / İSTANBUL
0 212 244 5177
0 212 244 5175 

 

MALIN
CİNSİ:
MARKASI:

MODELİ:  
SERİ NO:  

GARANTİ SÜRESİ: 2 (İKİ) YIL
AZAMİ TAMİR SÜRESİ: 30 (OTUZ) İŞ GÜNÜ

SATICI FİRMANIN
ÜNVANI:

 

ADRESİ:

 

___________________________________________________________________

TELEFONU:
FAKSI:
FATURA TARİH VE NO:

_____________________________________________
_____________________________________________

______________________ 
______________________ 
___________ / __________  

TARİH-İMZA-KAŞE:

ELEKTRONİK İNŞ. SAN. ve TİC. LTD. ŞTİ.

M
k

af
on Elektronk İnş.San.Ltd.Şt.Mikafon
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WARRANTY

WARRANTY: 2 (TWO) YEARS VALIDITY
MEAN TIME TO REPAIR: 30(THIRTY)
WORK DAYS



MİKAFON ELEKTRONİK İNŞ. SAN. LTD. ŞTİ.
Showroom:  Ş air  Z iya Paşa C ad.  No:  8/A 34420 Karaköy /  İSTANBUL

Intermediate Warehouse: Çatma Mescit Mah. Mektep Sok. No:8 Şişhane-Beyoğlu / İSTANBUL

Factory / Warehouse: Cumhuriyet Mah. Keten Sok. Şekerpınar-Çayırova / KOCAELİ

Telephone: +90 212 244 5177 (pbx) | Mobil: +90 533 657 8175 | Fax: +90 212 244 5175

E - m a i l :  i n f o @ m i k a f o n . c o m . t r  |  w w w . m i k a f o n . c o m . t r


